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1 What’s New in This 
Update of the User 
Guide?

TIP:  Need help? Send an email to cmecf_ca9help@ca9.uscourts.gov and please include 
information such as case numbers, filer's name, and any other information that can assist us in 
answering your question. You can expect a reply from the Court during the Court's business hours, 
from 8:30 AM to 5:00 PM Pacific Time.

This topic lists the additions and updates that were incorporated in each update of this guide.

August 1, 2009 Updates
• Updated logging in instructions and illustrations to reflect new checkbox that must now be 

selected to acknowledge that you understand that in order to file, you must comply with the 
redaction rules. See “Starting ECF” on page 16.

• Updated Macintosh users requirements. With the 2.1.3 release of CM/ECF, Macintosh users 
must update their system to have the latest Java updated released by Apple in June 2009. See 
“Prerequisites for Macintosh Users” on page 118.

July 9, 2009 Updates
• Added additional warnings throughout the guide about the size limit for PDF attachments.

• Added new chapter with step-by-step instructions for filing a petition for rehearing. See “Filing 
a Petition for Rehearing” on page 89.

• Added note about remote electronic access to documents in Social Security cases and 
immigration matters in “Document Links in a Notice of Docket Activity” on page 105.

• Updated “Types of Motions Available When Filing a Motion” on page 139 in “Motions/
Responses/Replies” on page 138 to include some reliefs that were previously only available 
when submitting a brief and a motion together: motion to file a late brief, motion to file 
nonstandard brief, and motion to file oversized brief.
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What’s New in This Update of the User Guide? >  
June 19, 2009 Updates
• Updated “To set Firefox as the default browser and clear the browser cache and cookies” on 

page 119 in “Macintosh Users and ECF” on page 117 to include illustrations and additional 
steps.

April 25, 2009 Updates
• Updated illustrations as needed throughout the guide to reflect minor changes in the interface.

• Completely revised and updated “Starting ECF” on page 16. Added additional illustrations, 
steps to change browser settings, and instructions for dealing with warning dialog boxes that 
may open.

April 17, 2009 Updates
• Updated “Macintosh Users and ECF” on page 117 to include additional configuration steps for 

filers who use a Macintosh system.

March 30, 2009 Updates
• Updated “Filing a Court Reporter Motion to Extend Time” on page 81 to include information 

about fill-in form available at Court website.

• Updated “Filing Categories and Types of Motions” on page 135:

• File a Response to a Motion renamed to File a Response to a Motion/Form

• File a Response to a Motion/Form added to the Forms/Notices/Disclosures category

• Added motion to extend time to file FRAP 9a memorandum to “Types of Motions 
Available When Filing a Motion” on page 139
8 -  ECF User Guide



What’s New in This Update of the User Guide? >  
March 14, 2009 Updates
• Updated guide to reflect changes in ECF version 2.1.1.

• Changed “Supported Browsers” to “Hardware and Software Requirements” on page 14 and 
included new information. Moved the “Screen Resolution” on page 14 topic into this new 
section.

• Expanded “Filing a Motion” on page 61 to include illustrations for each step of the filing 
process.

• Added new chapter, “Filing a Court Reporter Motion to Extend Time” on page 81. This chapter 
provides step-by-step instructions for filing a court reporter motion using the appellate ECF 
system.

• Added new chapter, “Macintosh Users and ECF” on page 117. This chapter provides 
information for Intel-based Mac users.

• Updated “Filing Categories and Types of Motions” on page 135 to reflect the addition of two 
new filing types:

• File a Response to a Court Order

• File a Reply to a Response to a Court Order

March 2, 2009 Updates
• Added new chapter, “Updating Your Appellate ECF Account” on page 151. This chapter 

provides step-by-step instructions for updating a company’s name or address, and for updating 
contact information for a registered attorney if that attorney changes firms.

February 23, 2009 Updates
• Updated “Submitting a Brief for Review by the Court” on page 49 to include illustrations for 

each step of the filing process.

• Updated “Filing Categories and Types of Motions” on page 135 to reflect changes in labels of 
filing types

• Filing type changes:

• File Court Reporter Motion renamed to File Court Reporter Motion to Extend 
Time

January 9, 2009 Updates
• Updated “Filing Categories and Types of Motions” on page 135 to reflect changes in labels of 

filing categories and types and to include new filing types

• Category changes:
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What’s New in This Update of the User Guide? >  
• Court Reporters/Transcripts renamed to Transcripts/Court Reporters

• Filing type changes:

• File Correspondence to Clerk Related to Pending Case (9th Cir.R.25-2) renamed to 
File Correspondence to Court

• File Court Reporter Correspondence to Clerk Related to Pending Case renamed to 
File Court Reporter Correspondence to Court

• (New filing type) In the Briefs category, added File an Errata to a Brief

• (New filing type) In the Rehearing/Reconsideration category, added File a Reply to 
an Answer to a Petition for Rehearing/En Banc

• Updated “Checking the Service List for a Case” on page 47

November 8, 2008 Updates - Version 2.1
• Updated “Screen Resolution” on page 14

• Updated: “Completing an Electronic Filing” on page 32

• Updated: “Selecting the Filing Party” on page 39

• Updated: “Attaching PDF Documents to Filings” on page 44

• Updated: “Submitting a Brief for Review by the Court” on page 49

• Updated: “Types of Motions Available When Submitting a Brief and Filing a Motion Together” 
on page 137

• New: “Creating Cross-Document Hyperlinks” on page 107

September 18, 2008 Updates
• New: “Filing a Motion and a Response to a Motion Together” on page 71

• Other minor updates throughout the guide.

September 9, 2008 Updates
• New: “Submitting a Brief for Review by the Court” on page 49

• Updated: “Filing a Motion” on page 61 (minor updates)

• New: “Filing Categories and Types of Motions” on page 135
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2 Getting Started

The topics below provide information that you may find useful when using ECF in the United 
States Court of Appeals for the Ninth Circuit.

• “Typographical Conventions Used in This Documentation” on page 12

• “ECF Application Overview” on page 13

• “Hardware and Software Requirements” on page 14

• “Starting ECF” on page 16

• “Stopping ECF” on page 23

• “Updating Your Account Information” on page 24

• “Screen Resolution” on page 14

• “Windows in ECF” on page 25

• “Drop-Down Lists” on page 27

• “Radio Buttons” on page 28

• “Date Fields” on page 29
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Getting Started >  Typographical Conventions Used in This Documentation
Typographical Conventions Used in This 
Documentation
This documentation uses the typographical conventions described in Table 1.

Table 1.  Typographical Conventions

Formatting Description Examples

text Fixed Courier font.
Used for text that you must type in exactly as 
shown, for keyboard keys that you must press, 
for predefined values in drop-down lists.

In the Confirm field, type YES.

Press Alt-F1.

text Bold.
Used for labels in the user interface of ECF, 
such as area labels, field names, and button 
labels.

From the Category drop-down list, 
select Motions.

text Italic.
Used for variable information that you must 
enter in ECF. Also used for new terms when 
they are first defined in the guide.

In the Attorney field, type the name of 
the attorney for the case.

In the Date field, type today’s date.

In ECF, the File Date is the date that the 
Court considers something filed.

> Greater than sign.
Used to indicate a navigation path in menus.

Choose Reports > Service List.
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Getting Started >  ECF Application Overview
ECF Application Overview
Case Management/Electronic Case Files (CM/ECF) is an automated case management and 
docketing system designed specifically for the federal courts. The case management and docketing 
(CM) portion is used by the courts. The electronic case files (ECF) portion allows courts to manage 
documents electronically; provide 24-hour desktop access to case files by judges, court staff, and 
the public; and accept filings over the Internet.

Electronic case files are documents stored in electronic format instead of on paper. Documents can 
be created electronically by parties and court staff or paper copies can be scanned. All documents 
are stored in Portable Document Format (PDF).

The ECF portion of the system is easy to use and allows a court to store, retrieve, review and send 
case documents in a reliable and secure electronic format. ECF also offers the following benefits:

• Twenty-four hour access to case files from any location

• Remote document filing

• Concurrent access to files

• Immediate e-mail notification of case activity to parties and court staff 

• Easy public access

• Secure storage of documents
ECF User Guide -  13



Getting Started >  Hardware and Software Requirements
Hardware and Software Requirements
The information in this section will help you to determine which hardware and software you need 
to run ECF.

Supported Browsers

ECF has been tested successfully using Firefox 3.0, and Internet Explorer 6 and 7 as representative 
browsers. All testing was performed using the Java Plug-In version 6 (also referred to as 1.6).

Java

You must have at least Java Version 6 Update 1 to use ECF. If you do not have Java on your 
computer (or if you aren't sure if you do) go to http://www.java.com/. You will note that there is a 
question/link below the Free Java Download button which asks Do I have Java? If you are not 
sure whether you have it, this link will run a diagnostic check on your computer and let you know 
whether it is already loaded. If you need to download or update Java, simply click the Free Java 
Download button and follow the directions on the subsequent pages. The Java Version 6 download 
is free, and the program takes only a few minutes to load.

NOTE:  Add-on toolbars, such as the Google toolbar are known to interfere with ECF, so we 
strongly suggest that you do not download or install add-on toolbars unless you know how to 
configure those toolbars so that they do not interfere with ECF.

Screen Resolution

The minimum screen resolution required to run ECF is 1024 x 768 pixels. If the screen resolution 
for your workstation is lower, you must change the resolution before you start using ECF. You do 
not have to make any changes to your screen resolution if the current setting is higher than 
1024 x 768 pixels.

CAUTION:  If you do not adjust your screen resolution, you may not see all the information you 
need to see in order to enter a filing in ECF. 

For example, when you click the Continue button at the File a Document screen, the system will 
open a warning dialog box that you need to review in order to continue the filing. Each warning in 
that dialog box has a corresponding Continue checkbox all the way on the right of the dialog box, 
and you may not be able to see those checkboxes if your screen resolution is not high enough. In 
order to proceed with a filing, you must select each Continue checkbox before clicking the OK 
button.
14 - ECF User Guide
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Getting Started >  Hardware and Software Requirements
Another possible issue may be that you do not see all the messages in the warning dialog box, in 
which case you may need to use the scrollbar on the right of the dialog box to see all the messages.

An example of a complete warning dialog box is shown in Figure 1. In this example, you would 
have to select the 5 Continue checkboxes and then click the OK button to proceed with the filing.

Macintosh Users

The Apple Macintosh platform can now be used to run all parts of the ECF with no extra software. 
See “Macintosh Users and ECF” on page 117 for details.

Additional Information About Technical Requirements

For additional information about technical requirements, please see What hardware and software 
will attorneys need to participate in CM/ECF? in the ECF Frequently Asked Questions page at 
PACER (http://pacer.psc.uscourts.gov/cmecf/ecffaq.html).

Figure 1.  A Warning Dialog Box in ECF
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Getting Started >  Starting ECF
Starting ECF
After you log in to ECF, the Startup Page window opens. 

1. Open a web browser window and navigate to the following URL:
https://ecf.ca9.uscourts.gov/cmecf/servlet/TransportRoom?servlet=Login 

The Appellate CM/ECF Login page, shown in Figure 2, opens.

CAUTION:  Notice the checkbox labeled “I understand that, if I file, I must comply with the 
redaction rules. I have read this notice.” You must select this checkbox to log in to ECF.

2. Make sure you select the redaction rule checkbox to acknowledge that you understand that 
you must comply with the redaction rules. The checkbox is located immediately above the 
Authentication box. 

Figure 2.  Appellate CM/ECF Login Page
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Getting Started >  Starting ECF
3. In the Login field, type your Appellate ECF login name and in the Password field, type your 
password.

NOTE:  The Login and Password fields are case-sensitive.

4. (Optional) In the Client Code field, enter a code to identify the person using the account.

This information is only referenced by PACER.

5. Click the Login button.

NOTE:  If the cookies settings are not acceptable for ECF, the system shows you an error 
message. An example of the message is shown in Figure 3. If this message appears, do one of 
the following:

• If you are using Internet Explorer, go to Step 6 on page 18.

• If you are using Firefox, go to step Step 7 on page 19.

Figure 3.  Warning - Cookies
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Getting Started >  Starting ECF
6. To change cookies-related settings in Internet Explorer, do the following:

a. In Internet Explorer, choose Tools > Internet Options.

b. In the Internet Options dialog box, click the Privacy tab.

c. Under Settings, click the Sites button.

d. In the Per Site Privacy Actions dialog box, in the Address of Web site field, type 
ecf.ca9.uscourts.gov and click the Allow button.

The Managed Web Sites list should now contain an entry for uscourts.gov, and the 
setting should be Always Allow. An example of what the dialog box should look like is 
shown in Figure 4.

e. In the Per Site Privacy Actions dialog box, click the OK button.

f. In the Internet Options dialog box, click the OK button.

g. Restart Internet Explorer and go back to Step 1 on page 16.

Figure 4.  Per Site Privacy Actions Dialog Box - Correct Settings
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7. To change cookies-related settings in Firefox, do the following:

a. In Firefox, choose Tools > Options.

b. In the Options dialog box, click the Privacy icon at the top.

c. Under Cookies, click the Exceptions button.

d. In the Exceptions - Cookies dialog box, in the Address of web site field, type 
ecf.ca9.uscourts.gov and click the Allow button.

The Site/Status list should now contain an entry for ecf.ca9.uscourts.gov, and the 
setting should be Allow. An example of what the dialog box should look like is shown in 
Figure 5.

e. In the Exceptions - Cookies dialog box, click the Close button.

f. In the Options dialog box, click the OK button.

g. Restart Firefox and go back to Step 1 on page 16.

Figure 5.  Exceptions - Cookies Dialog Box - Correct Settings
ECF User Guide -  19



Getting Started >  Starting ECF
8. If a Warning-Security dialog box opens, do the following:

a. Select the Always trust content from this publisher checkbox.

b. Click the Run button.

This dialog box will only open the first time you start ECF if you follow the steps above. An 
example of this dialog box is shown in Figure 6.

Figure 6.  Warning - Security
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Getting Started >  Starting ECF
The following happens:

c. A browser window, shown in Figure 7, opens. 

This window, which remains open in the background, is titled CM/ECF Appellate and the 
top of the page reads “U.S. Court of Appeals CM/ECF”. The large CM/ECF button initially 
appears with an orange Java logo. Wait until that logo disappears and the button contains 
the text CM/ECF as shown in Figure 7. 

CAUTION:  Do not close this window at any time. 

d. The Startup Page window opens in the foreground. 

An example is shown in Figure 8 on page 22. Notice that your last login date and time are 
shown near the middle of the page.

CAUTION:  Do not close the Startup Page window at any time. If you do close this 
window by accident, find the background window, shown in Figure 7, and click the large 
CM/ECF button.

Figure 7.  CM/ECF Appellate Browser Window
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Figure 8.  Startup Page Window
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Stopping ECF
To ensure that the different pieces of the application close correctly, you should always logout from 
ECF.

1. From the menu bar of any active ECF window, choose Logout > Logout CM/ECF.

A Confirm Logout dialog box, shown in Figure 9, opens.

2. Click the Yes button.

ECF logs you out and closes all its windows.

Figure 9.  Confirm Logout Dialog Box
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Updating Your Account Information
The quickest way to update your account information is to navigate to the Appellate Filer Account 
Update page and submit your changes. Use this URL to get started: https://pacer.psc.uscourts.gov/
psco/cgi-bin/cmecf/ea-login.pl.

You can also access the Appellate Filer Account Update page from within ECF:

1. From the menu bar of any active ECF window, choose Utilities > Update My Account.

The User Account Profile window opens. An example of this window is shown in Figure 10.

2. Click the Edit My Information button.

A new browser window opens with the Appellate Filer Account Update page.

Review the Frequently Asked Questions at http://www.ca9.uscourts.gov/cmecf/faqs to answer 
any questions you may have about updating your appellate ECF filer account information.

In addition, please review “Updating Your Appellate ECF Account” on page 151 for step-by-
step instructions for updating your address, firm name, and email addresses.

Figure 10.  User Account Profile Window
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Windows in ECF
In ECF, most windows are divided into several parts: a title bar, a menu bar, a screen area, and an 
area at the bottom of the window that contains command buttons. An example of a window is 
shown in Figure 11. 

Title Bar

The title bar contains the following elements: the ECF icon, the title of the window, and the 
standard window controls (minimize, maximize/restore, and close).

Figure 11.  A Window in ECF
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Menu Bar

The menu bar contains a number of menus that contain commands. In Figure 12, Docketing, 
Reports, Utilities, Logout, and Help are menus. Notice for Cases of Interest and Update My 
Account are commands or menu items.

Command Button Area

The command button area contains the buttons that let you continue or step back in a process.

In most cases, you can also use the Cancel button in this area to cancel the process you are 
currently working on. An example of a set of command buttons is highlighted in Figure 13.

Figure 12.  Menu Bar

Figure 13.  Command Buttons
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Drop-Down Lists
A drop-down list contains a set of predefined values. In Figure 14, there are two drop-down lists, 
Category and Description. The Description drop-down list is the active drop-down list (the 
values that you can select are visible).

To select a value in a drop-down list
• Using the mouse, click the down arrow of the drop-down list and select a value in the list.

• Using the keyboard, type the first characters of the value to select the first matching value in 
the list.

• Using the keyboard, use the up arrow () and down arrow () to navigate up and down 
in the list and select the highlighted value in the list.

Figure 14.  Drop-Down List
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Radio Buttons
A radio button is a control that you turn on by selecting the radio button. Radio buttons are mutually 
exclusive. This means that if you select one radio button in a group, you will not be able to select 
another radio button in that same group. In some cases, selecting a radio button changes the other 
user interface elements in the application. 

Figure 15 shows two sets of radio buttons. The set on the left represents categories, the set on the 
right represents a type of filing. In Figure 15, the Motions/Responses/Replies radio button and the 
File a Response to a Motion/Form radio buttons are selected.

Figure 15.  Radio Buttons Example
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Date Fields
A date field is a field where you must enter a date in one of the following supported formats:

• mm/dd/yy or mm/dd/yyyy 

Example: 7/2/07 

• mm-dd-yy or mm-dd-yyyy 

Example: 7-02-2007 

• mm.dd.yy or mm.dd.yyyy 

Example: 7.2.07 

In ECF, you can also fill in a date field by selecting a date from a pop-up calendar.

To use the pop-up calendar to fill in a date field

1. Make the date field the active field, right-click and choose Select Date from Calendar from 
the pop-up menu.

A pop-up window opens with a calendar, as shown in Figure 16.

Figure 16.  Calendar Pop-Up
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TIP:  Use the navigation buttons at the top of the calendar to quickly view the calendar for 
another month and year.

• Click the << button to go to the previous year without changing the month. In the example 
in Figure 16, clicking the << button would show March 2008.

• Click the < button to go to the previous month. In the example in Figure 16, clicking the < 
button would show February 2009.

• Click the > button to go to the next month. In the example in Figure 16, clicking the > 
button would show April 2009.

• Click the >> button to go to the next year without changing the month. In the example in 
Figure 16, clicking the >> button would show March 2010.

2. Click a date to fill in the date field from where you invoked the calendar.

The calendar pop-up closes.
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3 An Overview of Filing

The topics listed below describe the process of filing in ECF. In ECF, you use the Docketing menu 
to start filing a document.

• “Completing an Electronic Filing” on page 32

• “Finding and Selecting the Filing Type” on page 38

• “Selecting the Filing Party” on page 39

• “Selecting Related Previous Entries for a Filing” on page 42

• “Selecting Reliefs for a Filing” on page 40

• “Attaching PDF Documents to Filings” on page 44

• “Checking the Service List for a Case” on page 47
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Completing an Electronic Filing
You start the filing process by opening the File a Document window.

1. From the Docketing menu, choose File a Document.

The File a Document window, shown in Figure 17, opens.

Figure 17.  File a Document Window
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2. In the Case field, type the number of the case for which you are entering the filing and press 
the Tab key.

Notice that the case number and title now appear below the menu bar in the File a Document 
window. In addition, the case number and title appear in the Case Selection box in the lower 
part of the window. The highlighted areas in Figure 18 indicate where the case information 
appears.

Figure 18.  File a Document Window With Case Information
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3. If other case numbers appear in the Case Selection box (another example is shown in 
Figure 19), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

You are now ready to find the filing type so you can enter your filing.

4. Use the information in “Finding and Selecting the Filing Type” on page 38 to make your 
selections to identify the type of filing you are entering.

5. Click the Continue button.

Depending on the type of filing you selected, a warning dialog box may open. If this happens, 
carefully review the information in the dialog box, select the appropriate Continue 
checkboxes, and click the OK button.

A screen opens where you enter details about the filing. 

6. Use the information in the topics below to determine how to complete the different areas in the 
screen.

• “Selecting the Filing Party” on page 39

• “Selecting Reliefs for a Filing” on page 40

• “Selecting Related Previous Entries for a Filing” on page 42

• “Attaching PDF Documents to Filings” on page 44

• “Checking the Service List for a Case” on page 47

Figure 19.  Multiple Cases in Case Selection Box
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7. After you complete information in a details screen, click the Continue button.

If more information is needed for the filing, another details screen opens. In this case, fill in the 
necessary information and click the Continue button again.

When you have entered all the information for the filing, and you have clicked the Continue 
button, the Docket Text dialog box opens. An example of the Docket Text dialog box, for a 
response opposing a motion, is shown in Figure 20.

The Docket Text dialog box shows you the text of the entry as it will appear on the docket once 
you complete the filing. You cannot change the text in this dialog box. 

TIP:  If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

Figure 20.  Docket Text Dialog Box
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8. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box. An example of the Event Review dialog box is shown 
in Figure 21.

CAUTION:  This is the “point of no return.” 

TIP:  If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

9. Click the Submit button to confirm your filing.

The Event Docketed message dialog box, shown in Figure 22, opens. 

Figure 21.  Event Review Dialog Box

Figure 22.  Event Docketed Dialog Box
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10. Click the OK button.

A browser window opens with the notice of docket activity for your filing. An example of a 
browser window with a notice of docket activity is shown in Figure 23.

TIP:  If you are not seeing the notice in a new browser window, check your pop-up blocker 
settings. You must allow pop-ups from the Court’s site.

This completes the filing process. 

Figure 23.  Notice of Docket Activity for Filing
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Finding and Selecting the Filing Type
The File a Document window has two areas that let you select the type of filing. Those areas are 
highlighted in Figure 24. This document refers to the area on the left as the categories list, and the 
area on the right as the filing types list. The filing types list is labeled Select One.

When you click a category in the categories list, a list of filing types appears in the area labeled 
Select One. 

For example, to file a response to a motion, you would select the Motions/Responses/Replies 
radio button in the categories list, and then select the File a Response to a Motion/Form in the 
filing types list.

Figure 24.  Filing Type
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Selecting the Filing Party
When you file a document, you will have to identify the parties that you represent in the appeal. If 
you are a pro se filer, you must identify yourself at this stage of the process. You identify the parties 
in the Party Filer area. The Party Filer area shows a list of all the parties in a case. If you are a 
pro se filer, your name will appear in this area.

Figure 25 shows an example of the Party Filer area without any selections. To select an entry, you 
must click the checkbox to the left of the Filer column. When a filer is selected, a checkmark 
appears in the checkbox and the row is highlighted. In Figure 26, the filer ABC Fiction Team is 
selected.

TIP:  You can use the Select All and Clear All buttons to select or clear all the entries in the list in 
the Party Filer area.

Filing Joint Documents
If you are filing a joint document on behalf of multiple parties, select all the parties who joined in 
the document.

Figure 25.  Party Filer Area - No Selections

Figure 26.  Party Filer Area - Selection Made
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Selecting Reliefs for a Filing
When you file a motion, you must select at least one relief. A relief describes your motion for the 
Court. You select reliefs in the Relief area. 

Figure 27 shows an example of the Relief area without any selections. 

To select a relief

1. From the Category drop-down list, select a category of reliefs.

Selecting a value from the Category drop-down list filters the values available in the 
Description drop-down list. An example of the Category drop-down list, in expanded state, is 
shown in Figure 28.

Figure 27.  Relief Area - No Selections

Figure 28.  Relief Area - Category Drop-Down List
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2. From the Description drop-down list, select a relief.

An example of the Description drop-down list, in expanded state, is shown in Figure 29.

3. Click the Apply button.

Your selection now appears in the Selected Reliefs list, as shown in Figure 30.

TIP:  You can use the Remove button to remove one selected entry, or the Clear All button to 
clear all the entries in the list.

4. To add another relief, repeat Step 1 - Step 3.

Figure 29.  Relief Area - Description Drop-Down List

Figure 30.  Relief Area - Relief Selected
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Selecting Related Previous Entries for a Filing
In some types of filings, such as responses, you may be required to select the entry to which your 
filing applies. You do this using the Related Previous Entries area.

Figure 27 shows an example of the Related Previous Entries area without any selections. You can 
click the document icon in the Doc column to see the document that is attached to the entry on the 
Court’s docket. You may have to log in to PACER if you are not already logged in.

To select a previous entry

1. In the list of entries, click the entry to which your filing applies.

The system highlights your selection. In Figure 32, the second entry in the list is highlighted.

Figure 31.  Related Previous Entries Area - No Selections

Figure 32.  Related Previous Entries Area - Entry Highlighted
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2. Click the Add button.

The system adds your selection to the Selected Entries list. An example is shown in Figure 33.

TIP:  You can use the Remove button to remove one selected entry, or the Clear All button to clear 
all the entries in the list.

Figure 33.  Related Previous Entries Area - Selected Entries List
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Attaching PDF Documents to Filings
In ECF, you must always attach a PDF when you file a document. You attach documents to an 
event using the PDF Document area, shown in Figure 34.

CAUTION:  Each PDF that you attach to your filing may not exceed 5 MB in size.

To attach a document

1. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 35. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

2. Navigate to and select the PDF file you want to attach.

Figure 34.  PDF Document Area

Figure 35.  Select PDF document Dialog Box
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3. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 36.

4. To attach another document, such as the certificate of service or a declaration in support of a 
motion, click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 37.

5. Click the Browse button that was just added.

6. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

7. Click the OK button.

8. In the Description field next to the file that you just added, type a description for the 
attachment.

Figure 36.  PDF Document Area With One Document Selected

Figure 37.  PDF Document Area After Clicking Add Another
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TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 38.

9. To attach another document, return to Step 4 on page 45.

Figure 38.  PDF Document Area With Description Field Completed For Standard Form
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Checking the Service List for a Case
Before you file a document, make sure you review the service list for the case or cases so you know 
which attorneys or parties to serve by US Mail. You can check the service list for a case at any time.

TIP:  If you find that you cannot access the service list for a case, a pop-up blocker may be at work 
in your browser. The best way to check is to turn on the sound on your system, then try to access 
the Service List (Reports > Service List) or the Help (Help > Help), you should hear a distinctive 
little “ding” which indicates that there is something blocking a web page from opening. Make sure 
you change the pop-up blocker settings to allow all pop-ups from our site.

To check the service list for a case

1. From the Reports menu, choose Service List.

A new browser window opens. An example of what appears in the page is shown in Figure 39.

2. In the Case Number field, type the case number.

Figure 39.  Request Service List Page
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3. Click the Show Service List button.

The service list for the case is shown in the browser window. An example of the report is shown 
in Figure 40.

• If the word Active is in the ECF Filing Status column, then your electronic filing will 
constitute service to the party.

• If Not Registered, Exempt, Pending, Rejected, or Suspended is in the ECF Filing Status 
column, then you must serve this party by US Mail.

Figure 40.  Service List for a Case
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4 Submitting a Brief for 
Review by the Court

Before you start, make sure you review the information in “An Overview of Filing” on page 31, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to submit a brief for review by the Court.

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window, shown in Figure 41, opens.

Figure 41.  File a Document Window
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2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. Figure 42 illustrates this.

3. In the categories list, select the Briefs radio button.

The right part of the window is updated to show a list of possible filings in the Briefs category.

Figure 42.  File a Document Window With Case Title
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4. In the list labeled Select One, select the Submit Brief for Review by the Court radio button.

Figure 43 shows an example of the File a Document window with the filing category and type 
selected.

5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 44), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

Figure 43.  File a Document Window With Filing Category and Type Selected

Figure 44.  Multiple Cases in Case Selection Box
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6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 45.

7. For each warning message, read the warning, and select the Continue checkbox button on the 
right to confirm that you have read the message.

CAUTION:  If you read a warning and realize that you need to edit your brief, then do not 
continue with this event. In this case, click the OK button without selecting the checkboxes.

Figure 46 on page 53 shows an example of the warning dialog box with all the Continue 
checkboxes selected.

Figure 45.  Submit Brief for Review by the Court - Warning Dialog Box
52 - ECF User Guide



Submitting a Brief for Review by the Court >  
TIP:  If you do not see all the checkboxes, check your screen settings and make sure you are 
running at a screen resolution of at least 1024 x 768 pixels.

8. When you have reviewed all the warnings and selected all the Continue checkboxes, click the 
OK button.

A screen opens where you must enter additional information about the brief that you are 
submitting.

Figure 46.  Submit Brief for Review by the Court - Warning Dialog Box - Ready to Continue
ECF User Guide -  53



Submitting a Brief for Review by the Court >  
9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

Figure 47 shows an example of a Party Filer area with the Respondent party selected.

NOTE:  If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 39 for step-by-step instructions.

10. From the Type of Brief drop-down list, select the correct value.

CAUTION:  This drop-down list defaults to Opening. Make sure you select a different value 
if you are not submitting an opening brief.

11. In the Service Date field, type the date of service.

Figure 47.  Submit Brief for Review by the Court - Party Filer

o
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TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 47.

At this point, the screen should look similar to what is shown in Figure 48.

12. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 49. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

Figure 48.  Submit Brief for Review by the Court - Party Filer, Type of Brief, Service Date Completed

Figure 49.  Select PDF document Dialog Box
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13. Navigate to and select the PDF file you want to attach.

CAUTION:  Each PDF that you attach to your filing may not exceed 5 MB in size.

14. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 50.

15. To attach another document, such as the certificate of service, click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 51.

16. Click the Browse button that was just added.

17. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

18. Click the OK button.

19. In the Description field next to the file that you just added, type a description for the 
attachment.

Figure 50.  PDF Document Area With One Document Attached

Figure 51.  PDF Document Area After Clicking Add Another
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TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 52.

20. To attach another document, return to Step 15 on page 56.

At this point, the screen should look similar to what is shown in Figure 53.

Figure 52.  PDF Document Area With Description Field Completed For Standard Form

Figure 53.  Submit Brief for Review by the Court - Second Page Completed
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21. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 54, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

22. Click the Continue button.

The Event Review dialog box, shown in Figure 55, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

23. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 54.  Submit Brief for Review by the Court - Docket Text Dialog Box

Figure 55.  Submit Brief for Review by the Court - Event Review Dialog Box
58 - ECF User Guide



Submitting a Brief for Review by the Court >  
24. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.

An example of a notice of docket activity, in this case opened in a second tab in the browser 
window, is shown in Figure 56.

Figure 56.  Submit Brief for Review by the Court - Notice of Docket Activity
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5 Filing a Motion

Before you start, make sure you review the information in “An Overview of Filing” on page 31, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion.

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window, shown in Figure 57, opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

Figure 57.  File a Document Window
ECF User Guide -  61



Filing a Motion >  
TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. Figure 58 illustrates this.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.

Figure 58.  File a Document Window With Case Title
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4. In the list labeled Select One, select the File a Motion radio button.

Figure 59 shows an example of the File a Document window with the filing category and type 
selected.

5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 60), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

Figure 59.  File a Document Window With Filing Category and Type Selected

Figure 60.  Multiple Cases in Case Selection Box
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6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 61.

7. Read the warning and select the Continue checkbox button on the right to confirm that you 
have read the message.

8. Click the OK button.

A screen opens where you must enter additional information about the filing.

9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

Figure 62 shows an example of a Party Filer area with the Respondent party selected.

See “Selecting the Filing Party” on page 39 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion 
drop-down list.

Figure 61.  File a Motion - Warning Dialog Box

Figure 62.  File a Motion - Party Filer

o
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11. In the Relief area, select the relief that describes the motion by doing the following:

a. From the Description drop-down list, select the relief.

b. Click the Apply button.

c. Repeat Step a and Step b to add another relief.

Figure 63 shows an example of a Relief area with two reliefs selected: motion for attorney 
fees and motion for miscellaneous relief. 

See “Selecting Reliefs for a Filing” on page 40 for detailed instructions.

12. Click the Continue button.

Figure 63.  File a Motion - Relief Selected

o
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13. If you selected motion for miscellaneous relief, a Relief Preconditions dialog box opens. In 
this case, if you are sure there is no relief that matches your request, click the Continue 
checkbox, then click the OK button to continue.

Figure 64 shows an example of a Relief Preconditions dialog box.

Another screen opens where you must enter more information about the filing.

14. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 47.

15. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 65. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

Figure 64.  Relief Preconditions Dialog Box

o

Figure 65.  Select PDF document Dialog Box
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16. Navigate to and select the PDF file you want to attach.

CAUTION:  Each PDF that you attach to your filing may not exceed 5 MB in size.

17. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 66.

18. To attach another document, such as the certificate of service, click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 67.

19. Click the Browse button that was just added.

20. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

21. Click the OK button.

22. In the Description field next to the file that you just added, type a description for the 
attachment.

Figure 66.  PDF Document Area With One Document Attached

Figure 67.  PDF Document Area After Clicking Add Another
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TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 68.

23. To attach another document, return to Step 18 on page 67.

At this point, the screen should look similar to what is shown in Figure 69.

NOTE:  Depending on the relief or reliefs that you selected on the previous page, other 
Additional Information areas with additional fields may appear on the screen, such as 
Amount of Attorney Fees Requested, or Description of Miscellaneous Motion. If this 
happens, make sure you fill in those fields before continuing to the next step.

Figure 68.  PDF Document Area With Description Field Completed For Standard Form

Figure 69.  File a Motion - Second Page Completed
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24. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 70, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

25. Click the Continue button.

The Event Review dialog box, shown in Figure 71, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

26. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 70.  File a Motion - Docket Text Dialog Box

Figure 71.  File a Motion - Event Review Dialog Box
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27. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.

An example of a notice of docket activity, in this case opened in a second tab in the browser 
window, is shown in Figure 72.

Figure 72.  File a Motion - Notice of Docket Activity
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6 Filing a Motion and a 
Response to a Motion 
Together

Before you start, make sure you review the information in “An Overview of Filing” on page 31, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion and a response to a motion in one filing (and 
one document).

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.
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4. In the list labeled Select One, select the File a Motion and a Response to a Motion Together 
radio button.

Figure 73 shows an example of the File a Document window with the filing category and type 
selected.

Figure 73.  File a Document Window With Filing Category and Type Selected
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5. If other case numbers appear in the Case Selection box (an example is shown in Figure 74), 
make sure that you select the checkboxes for those additional cases where you want to enter 
your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 75.

Figure 74.  Multiple Cases in Case Selection Box

Figure 75.  File a Motion and a Response to a Motion Together- Warning Dialog Box
ECF User Guide -  73



Filing a Motion and a Response to a Motion Together >  
7. For each warning message, read the warning, and select the Continue checkbox button on the 
right to confirm that you have read the message.

An example of the dialog box with the Continue checkboxes selected is shown in Figure 76.

8. When you have selected all the Continue checkboxes, click the OK button.

A screen opens where you must enter additional information about the filing.

9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

Figure 77 shows an example of a Party Filer area with the Respondent party selected.

See “Selecting the Filing Party” on page 39 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion 
drop-down list.

Figure 76.  File a Motion and a Response to a Motion Together- Warning Dialog Box, Checkboxes Selected

Figure 77.  File a Motion and a Response to a Motion Together - Party Filer

o
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11. In the Relief area, select the relief that describes the motion by doing the following:

a. From the Description drop-down list, select the relief.

b. Click the Apply button.

c. Repeat Step a and Step b to add another relief.

Figure 78 shows an example of a Relief area with two reliefs selected: motion for attorney 
fees and motion for miscellaneous relief. 

See “Selecting Reliefs for a Filing” on page 40 for detailed instructions.

12. Click the Continue button.

Figure 78.  File a Motion and a Response to a Motion Together - Relief Selected

o
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13. If you selected motion for miscellaneous relief, a Relief Preconditions dialog box opens. In 
this case, if you are sure there is no relief that matches your request, click the Continue 
checkbox, then click the OK button to continue.

Figure 79 shows an example of a Relief Preconditions dialog box.

A screen opens with two areas: Additional Information and Related Previous Entries. An 
example is shown in Figure 80.

14. From the Response Type drop-down list, select the value that matches the type of response you 
are filing.

Figure 79.  Relief Preconditions Dialog Box

o

Figure 80.  Additional Information and Related Previous Entries Areas
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15. Use the controls in the Related Previous Entries area to select the motion for which you are 
filing a response.

See “Selecting Related Previous Entries for a Filing” on page 42 for step-by-step instructions 
for selecting the previous filing for which you are filing a response.

16. Click the Continue button.

Another screen opens where you must enter more information about the filing.

17. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 47.

18. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 81. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

19. Navigate to and select the PDF file you want to attach.

CAUTION:  Each PDF that you attach to your filing may not exceed 5 MB in size.

Figure 81.  Select PDF document Dialog Box
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20. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 82.

21. To attach another document, such as the certificate of service, click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 83.

22. Click the Browse button that was just added.

23. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

24. Click the OK button.

25. In the Description field next to the file that you just added, type a description for the 
attachment.

Figure 82.  PDF Document Area With One Document Attached

Figure 83.  PDF Document Area After Clicking Add Another
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TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 84.

26. To attach another document, return to Step 21 on page 78.

NOTE:  Depending on the relief or reliefs that you selected for your motion, other Additional 
Information areas with additional fields may appear on the screen, such as Amount of 
Attorney Fees Requested, or Description of Miscellaneous Motion. If this happens, make 
sure you fill in those fields before continuing to the next step.

27. Click the Continue button at the bottom of the screen.

The Docket Text dialog box opens. This dialog box shows you the text of the entry as it will 
appear on the docket once you complete the filing. You cannot change the text in this dialog 
box. 

28. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

29. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

30. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

Figure 84.  PDF Document Area With Description Field Completed For Standard Form
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7 Filing a Court Reporter 
Motion to Extend Time

Before you start, make sure you review the information in “An Overview of Filing” on page 31, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a court reporter motion to extend time.

TIP:  The Court has prepared a fill-in form that you can use for your motions. Check the Court’s 
Forms section in the ECF page at http:/www.ca9.uscourts.gov/cmecf.

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Transcripts/Court Reporters radio button.

The right part of the window is updated to show a list of possible filings in the Transcripts/
Court Reporters category.
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4. In the list labeled Select One, select the File a Court Reporter Motion to Extend Time radio 
button.

Figure 85 shows an example of what you have done so far: case number in Case field, 
Transcripts/Court Reporters and File a Court Reporter Motion to Extend Time radio 
buttons selected.

Figure 85.  File a Court Reporter Motion to Extend TIme
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5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 86), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 87.

7. Read the warning and select the Continue checkbox button on the right to confirm that you 
have read the message.

Figure 86.  Multiple Cases in Case Selection Box

Figure 87.  File a Court Reporter Motion to Extend Time - Warning Dialog Box
ECF User Guide -  83



Filing a Court Reporter Motion to Extend Time >  
8. Click the OK button.

A screen opens where you must enter additional information about the filing. An example of 
the screen is shown in Figure 88.

9. Do one of the following:

• If your name appears in the Court Reporter Filer area, select your name by selecting the 
checkbox to the left of the Filer column.

-or-

• If your name does not appear in the Court Reporter Filer area, type it in the text box in 
the Additional Information area.

10. Click the Continue button.

Another screen opens where you must enter more information about the filing.

11. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 47.

12. In the PDF Document area, click the Browse button to navigate to and select the PDF 
document of your motion.

TIP:  The Court has prepared a fill-in form that you can use for your motions. Check the Court’s 
Forms section in the ECF page at http:/www.ca9.uscourts.gov/cmecf.

Figure 88.  Identifying the Court Reporter Filer
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13. If you need to attach a separate document, do the following:

a. In the PDF Document area, click the Add Another button.

b. Click the Browse button to navigate to and select the PDF document of the certificate of 
service.

c. In the Description field, type the description of the document.

For step-by-step instructions, see “Attaching PDF Documents to Filings” on page 44.

Figure 89 shows an example of the Service and PDF Document areas filled in.

Figure 89.  Service and PDF Document Areas
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14. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 90, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

15. Click the Continue button.

The Event Review dialog box, shown in Figure 91, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

16. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 90.  File a Court Reporter Motion to Extend Time - Docket Text Dialog Box

Figure 91.  File a Court Reporter Motion to Extend Time - Event Review Dialog Box
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17. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.

An example of a notice of docket activity, in this case opened in a second tab in the browser 
window, is shown in Figure 92.

Figure 92.  File a Court Reporter Motion to Extend Time - Notice of Docket Activity
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8 Filing a Petition for 
Rehearing

Before you start, make sure you review the information in “An Overview of Filing” on page 31, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to request rehearing of an Opinion or a Memorandum 
Disposition.

The instructions in this topic apply to the following types of filings:

• Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1)

• Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1)

• Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40)

CAUTION:  If you want to request reconsideration of an Order, file a motion for reconsideration 
instead.

1. Make sure you have a PDF copy of the Opinion or Memorandum Disposition for which you 
are requesting the rehearing. 

You must attach the Opinion or Memorandum Disposition to your filing.
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2. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window, shown in Figure 93, opens.

3. In the upper part of the window, in the Case field, type the case number and press the Tab key.

Figure 93.  File a Document Window
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TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. Figure 94 illustrates this.

4. In the categories list on the left, select the Rehearing/Reconsideration radio button.

The right part of the window is updated to show a list of possible filings in the Rehearing/
Reconsideration category.

5. In the list labeled Select One, do one of the following:

• To request a rehearing by panel only, select the File a Petition for Panel Rehearing 
(FRAP 40; 9th Cir. R. 40-1) radio button.

Figure 94.  File a Document Window With Case Title
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• To request a rehearing by en banc panel only, select the File a Petition for Rehearing En 
Banc (FRAP 35; 9th Cir. R. 35-1) radio button.

• To request a rehearing by panel and en banc panel, select the File a Combination Petition 
for Panel Rehearing/En Banc (FRAP 35, 40)Submit Brief for Review by the Court 
radio button.

Figure 95 shows an example of the File a Document window with the filing category 
Rehearing/Reconsideration and available rehearing types highlighted.

Figure 95.  File a Document Window With Filing Category and Types Highlighted
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6. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 96), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

7. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 97.

Figure 96.  Multiple Cases in Case Selection Box

Figure 97.  File a Petition for Panel Rehearing - Warning Dialog Box
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8. For each warning message, read the warning, and select the Continue checkbox button on the 
right to confirm that you have read the message.

CAUTION:  If you want to request reconsideration of an Order, click the OK button to return to 
the previous screen, and select File a Motion for Reconsideration instead.

Figure 98 shows an example of the warning dialog box with all the Continue checkboxes 
selected.

TIP:  If you do not see all the checkboxes, check your screen settings and make sure you are 
running at a screen resolution of at least 1024 x 768 pixels.

9. When you have reviewed all the warnings and selected all the Continue checkboxes, click the 
OK button.

A screen opens where you must enter additional information about the rehearing request that 
you are filing.

Figure 98.  Submit Brief for Review by the Court - Warning Dialog Box - Ready to Continue
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10. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

Figure 99 shows an example of a Party Filer area with the Respondent party selected.

NOTE:  If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 39 for step-by-step instructions.

11. From the Requesting Rehearing of drop-down list, select the correct value.

CAUTION:  This drop-down list defaults to memorandum. Make sure you select opinion if 
you are requesting a rehearing of an opinion.

12. In the Date of Memorandum or Opinion field, type the date the memorandum or opinion was 
filed.

13. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 47.

Figure 99.  Submit Brief for Review by the Court - Party Filer

o
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14. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 100. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

15. Navigate to and select the PDF file of the petition for rehearing.

CAUTION:  Each PDF that you attach to your filing may not exceed 5 MB in size.

16. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 101.

Figure 100.  Select PDF document Dialog Box

Figure 101.  PDF Document Area With One Document, Petition for Rehearing, Attached
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17. To attach another document, such as the opinion or memorandum or the certificate of service, 
click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 102.

18. Click the Browse button that was just added.

19. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

20. Click the OK button.

21. In the Description field next to the file that you just added, type a description for the 
attachment.

TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 103.

Figure 102.  PDF Document Area After Clicking Add Another

Figure 103.  PDF Document Area With Description Field Completed For Standard Form
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22. To attach another document, return to Step 17 on page 97.

At this point, the screen should look similar to what is shown in Figure 104.

Figure 104.  File a Petition for Rehearing- Second Page Completed
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23. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 105, opens. This dialog box shows you the text 
of the entry as it will appear on the docket once you complete the filing. You cannot change 
the text in this dialog box. 

24. Click the Continue button.

The Event Review dialog box, shown in Figure 106, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

25. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 105.  File a Petition for Panel Rehearing - Docket Text Dialog Box

Figure 106.  File a Petition for Panel Rehearing - Event Review Dialog Box
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26. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.
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9 Working With Email 
Notices of Docket 
Activity

The topics below describe the notice of docket activity and explain how to save a copy of the 
documents attached to the notice.

• “What is in a Notice of Docket Activity?” on page 102

• “The Subject Line of a Notice of Docket Activity” on page 104

• “Document Links in a Notice of Docket Activity” on page 105
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What is in a Notice of Docket Activity?
A notice of docket activity is a notice that is generated whenever something is entered on the docket 
of a case. The top of the notice contains a disclaimer stating that public users may view the notice 
information once free of charge (“one free look”). After that, a fee will be assessed.

NOTE:  If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

The notice shows case information, docket text, the recipient names, and a hyperlink for the case 
number. In addition, the notice may include a link labeled Document(s). If you are logged in to 
PACER, clicking the case number hyperlink takes you to the Docket Report window from where 
you can generate a docket report. “Document Links in a Notice of Docket Activity” on page 105 
explains how the document links work. 
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An example of a browser window with a notice of docket activity is shown in Figure 107.

Figure 107.  Notice of Docket Activity for Filing
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The Subject Line of a Notice of Docket Activity
The subject line of a notice of docket activity shows the case number, the case title, and provides 
a short description of the activity that happened in the case.

Even if the notice applies to several cases, the subject line of a notice of docket activity only lists 
one case number! An example of this is a notice of oral argument. Usually, a notice of oral 
argument notice applies to all the cases that are scheduled to be heard on the same day, but only 
one case number will appear in the subject line of the notice of docket activity. The docket text 
includes information to let you know that you must open the documents attached to the notice to 
view details about your case. An example of docket text for a notice of oral argument is shown 
below.

Notice of Oral Argument on AUGUST Calendar. Please return 
ACKNOWLEDGEMENT OF HEARING NOTICE form to: SEATTLE Office. 
Attention: The Notice of Docket Activity may not list your case 
number. Please open attached documents to view details about 
your case. [07-30344, 07-30452, 07-30458, 07-30459, 07-35188, 
07-35341, 07-35610, 07-35841, 07-35907] 
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Document Links in a Notice of Docket Activity
A Document(s) link appears in the notice if one or more documents were attached to the activity 
in the docket.

You can click the Document(s) link to view the document or documents that were attached.

CAUTION:  Remote electronic access to documents in Social Security cases and immigration 
matters is limited to the attorneys or parties in the case in order to protect the privacy of the 
individuals involved in those cases. You may inspect these files in person in the Clerk's office. If 
you are a party or attorney in the case, you can access documents in these cases only by using your 
CM/ECF Filer ID and Password and choosing Reports > PACER Report after you have logged 
in to CM/ECF. See Rule 13 of the Administrative Order Regarding Electronic Filing in All Ninth 
Circuit Cases.

In ECF documents are attached in portable document format (PDF). This means that when you 
click a document link, the document opens in Adobe Reader or in another PDF-capable application 
on your system. For the purpose of this guide, we will assume that you are using Adobe Reader.

NOTE:  If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

To save a copy of a document attached to a notice of docket activity

1. In the notice of docket activity, click the Document(s) link.

NOTE:  If more than one document is attached to the entry, a page opens with a number of links. 
There is one link for each attached document. In this case, click the link of the document that 
you want to open.

The document opens in your web browser or in a separate Adobe Reader window, depending 
on your settings. 

2. Choose File > Save As (or Save A Copy, if Save As is not shown). 

-or-

Click the Save a Copy button in the toolbar.

3. In the Save As dialog box, enter the file name and location, and click the Save button. 
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10 Creating 
Cross-Document 
Hyperlinks

The topics below describe how to create a hyperlink in a PDF document, where the hyperlink links 
to another PDF document in a CM/ECF database. The document being referenced can be a 
document that was previously filed or a document that is being filed in the same transaction (filing) 
as the referencing document. The steps to create a hyperlink and to generate documents in PDF 
format are similar whether you are using WordPerfect or Word to create documents; differences are 
noted as needed.

• “Creating a Hyperlink to a Document Already Filed in a Case” on page 108

• “Creating Hyperlinks Between Documents in the Same Filing” on page 112
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Creating a Hyperlink to a Document Already 
Filed in a Case
You can create a link to another document in any database in the Federal Courts: District, 
Bankruptcy (as of December 2006) or Appellate (as of July 2006, Version 1.3).

1. Access CM/ECF and run the docket report for the case in which the document was filed.

2. Locate the document among the docket entries.

3. Copy the URL (the “address”) of the document to the clipboard by doing the following:

a. Hover over the document link and click the right mouse button (the document link displays 
after the docket date and is represented by an icon or a number with an underscore, for 
example, 5).

b. From the pop-up menu, choose Copy Shortcut or Copy Link Location (the option you 
will see depends on your browser),

CAUTION:  DO NOT copy the URL from the browser’s address bar when the document is 
open.

An example of the pop-up menu in Internet Explorer is shown in Figure 108.

4. Open the word processing document.

Figure 108.  Pop-up Menu for Document in Docket Report
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5. In the document, highlight the citation text for which you want to create the hyperlink.

An example is shown in Figure 109.

6. If you are using WordPerfect, go to: “To create the hyperlink and produce a PDF in 
WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink and produce a PDF in Word” on 
page 110.

To create the hyperlink and produce a PDF in WordPerfect

1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 110.

2. Press Ctrl-V to paste the URL into the Document/Macro field.

Figure 109.  Highlight Hyperlink Text

Figure 110.  Hyperlink Properties Dialog Box
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3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file.

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE:  If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your document and upload the PDF with hyperlinks.

To create the hyperlink and produce a PDF in Word

1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 111.

Figure 111.  Insert Hyperlink Dialog Box
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2. Press Ctrl-V to paste the URL into the Address field.

3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file by following the steps below. 

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your document and upload the PDF with hyperlinks.
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Creating Hyperlinks Between Documents in the 
Same Filing
Instead of linking to a previously-filed document, you can link a document to another document 
that you will be filing at the same time. For example, you could create a hyperlink from your main 
document to an attachment. 

When you create the link, it points to the referenced document where it exists on your local system 
or network and when the documents are filed in CM/ECF, the link is converted to an “address” in 
CM/ECF.

1. Create PDF versions of any secondary documents, such as attachments or exhibits, that will be 
referenced by the main document. 

2. Open the main document in the word processing program.

The main document is the document that will have hyperlinks to the secondary documents.

3. In the main document, highlight the text for which you want to create the hyperlink to the 
secondary document.

4. If you are using WordPerfect, go to: “To create the hyperlink to an attachment and produce a 
PDF in WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink to an attachment and produce a PDF in 
Word” on page 114.

To create the hyperlink to an attachment and produce a PDF in WordPerfect

1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 112.

Figure 112.  Hyperlink Properties Dialog Box
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2. Click the folder icon to the right of the Document/Macro field.

The Select File window opens.

3. Navigate to and select the PDF file that you want to link to and click the Select button.

The Document/Macro field in the Hyperlink Properties dialog box now shows the file you 
selected.

4. Click the OK button.

5. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

6. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

7. Save the word processing document.

8. Produce the PDF file.

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE:  If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your documents and upload the PDF with hyperlinks.
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To create the hyperlink to an attachment and produce a PDF in Word

1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 113.

2. Navigate to and select the PDF file that you want to link to.

3. The Address field in the Insert Hyperlink dialog box now shows the file you selected.

4. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

5. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

6. Save the word processing document.

Figure 113.  Insert Hyperlink Dialog Box
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7. Produce the PDF file by following the steps below. 

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your documents and upload the PDF with hyperlinks.
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11 Macintosh Users and 
ECF

The topics below provide information specific to Macintosh users that will be useful when using 
ECF in the United States Court of Appeals for the Ninth Circuit.

The Apple Macintosh platform can now be used to run all parts of the ECF with no extra software. 

• “Prerequisites for Macintosh Users” on page 118

• “Starting ECF on a Mac” on page 124

• “Known Differences for Mac Users” on page 128

• “Known Java Issues for Mac Users” on page 130
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Prerequisites for Macintosh Users
Both the hardware and the operating system (OS X) must be 64 bit. All Macintosh computers made 
in about the last 18 months are 64-bit capable. In summary, you need:

• 64-bit capable Macintosh

• OS X 10.5 (or higher)

• Java 1.6 Update 13

You must install the latest Java update for Macintosh users, released by Apple on 18 June 2009 
as Java for Mac OS X 10.5 Update 4 (this is Java 1.6 Update 13). 

You will not be able to log in if you have not installed this update. 

CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 130 before you attempt to start ECF.

NOTE:  If you have an Intel-based Mac that is not 64-bit capable, you may be able to use one of the 
parallel operating system products, such as Fusion or Parallels, that allow a Mac to mimic the 
Windows operating system. Fusion and Parallels only run on Intel-based Mac systems.

Before you start, make sure you do the following:

1. Verify that you have the correct Java version, see “To verify that you have the correct Java 
version” below.

2. Configure your browser to accept cookies.

3. Decide which browser you want to use for ECF, define that browser as the default browser to 
use, and clear the browser cache and cookies. See one of the topics below for step-by-step 
instructions:

• “To set Firefox as the default browser and clear the browser cache and cookies” on 
page 119 

• “To set Safari as the default browser and clear the browser cache and cookies” on page 123

To verify that you have the correct Java version

1. From Finder, click Go, then click Applications.

2. In Applications, expand Utilities, then expand Java.

3. Double-click Java Preferences.

The Java Preferences dialog box opens.
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4. Drag the entries up and down to match the order shown in Figure 114. 

CAUTION:  If you do not see Java SE 6, you do not have the latest version of Java. In this case, 
download it from Apple, install the update and start again.

To set Firefox as the default browser and clear the browser cache and cookies

1. Open Firefox.

2. Choose Firefox > Preferences.

3. In the dialog box that opens, click the Advanced icon at the top, then make sure the General 
tab is the active tab.

4. At the bottom of the dialog box, under System Defaults, click the Check Now button to check 
and set Firefox as the default browser.

5. Click the Privacy icon at the top.

Figure 114.  Java Preferences Updated
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6. Under Cookies, make sure the Accept cookies from sites and Accept third-party cookies 
checkboxes are selected. 

An example is shown in Figure 115.

Figure 115.  Cookies Section in Firefox Preferences
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7. Click the Show Cookies button.

The Cookies dialog box opens. An example is shown in Figure 116.

8. In the Cookies dialog box, click the Remove All Cookies button.

The Cookies dialog box should look similar to the one shown in Figure 117.

9. Close the Cookies dialog box.

Figure 116.  Cookies Dialog Box

Figure 117.  Cookies Dialog Box, After Remove All Cookies
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10. Back in the Preferences dialog box, under Private Data, click the Settings button.

The Private Data area is highlighted in Figure 118.

A smaller dialog box with privacy settings opens. An example is shown in Figure 119.

11. Select the Cache, Cookies, Offline Website Data, and Authenticated Sessions checkboxes 
and click the OK button.

Figure 118.  Private Data Area

Figure 119.  Privacy Settings
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12. Back in the Preferences dialog box, under Private Data, click the Clear Now button.

The Private Data area is highlighted in Figure 118 on page 122.

13. In the Clear Private Data dialog box that opens, click the Clear Private Data Now button.

14. Close the Preferences dialog box.

To set Safari as the default browser and clear the browser cache and cookies

1. Open Safari.

2. Choose Safari > Preferences.

3. In the dialog box that opens, click the General icon at the top.

4. From the Default web browser drop-down list, select Safari.

5. In the dialog box, click the Security icon at the top.

6. Under Accept Cookies, click the Show Cookies button.

7. In the dialog box that opens, click the Remove All button, then click the Done button.

8. Close the Preferences dialog box.

9. Choose Safari > Empty Cache.

10. In the dialog box that opens, click the Empty button.
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Starting ECF on a Mac
CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 130 before you attempt to start ECF.

NOTE:  The launching process described in this topic has been tested using the Safari and the 
Firefox browsers. Other browsers may work.

After you enter your login and password and you click the Login button, the browser may ask what 
to do next. This one-time setup is to associate the Java Network Launching Protocol (JNLP) file 
with Java Web Start. The dialog box shown in Figure 120 opens.

1. If the dialog box shows Java Web Start in the drop-down list next to Open with, then 
select the Open with radio button and go to step Step 3 on page 126.

Figure 120.  Opening k2jnlp.jsp Dialog Box
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2. If you see a Choose button next to the Open with radio button, then click Choose to select the 
helper application.

A dialog box similar to the one shown in Figure 121 opens.

Do the following:

a. In the left hand list, find and click the entry labeled Utilities.

b. In the list on the right, find and click the entry labeled Java.

This shows the list of helper applications for Java, as shown in Figure 122.

Figure 121.  Choose Helper Application
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c. Click Java Web Start and click the Open button.

3. Select the checkbox labeled Do this automatically for files like this from now on so that you 
do not have to do this twice. 

4. Click the OK button.

A Java Starting message box opens and then the system may ask you to authenticate the 
certificate. 

5. If a certificate dialog box opens asking you if you want to accept the certificate from 
“ecf.ca9.uscourts.gov,” click the Trust button to continue.

Another certificate dialog box opens. This time, you must click the Trust button to ensure that 
ECF will be able to read PDF files from your Mac. The PDF certificate dialog box will look 
similar to the one shown in Figure 123.

Figure 122.  Choose Helper Application - Java

Figure 123.  PDF Certificate
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6. Click the Trust button.

At this point, a small window with a blue CM/ECF label opens. This is the program itself. An 
example of this window is shown in Figure 124. 

CAUTION:  Do not close this window at any time. 

The Startup Page window opens in the foreground. Notice that your last login date and time are 
shown near the middle of the page. An example of this window is shown in Figure 125.

CAUTION:  Do not close the Startup Page window at any time. If you do close this window 
by accident, find the background window, shown in Figure 124, and click the large CM/ECF 
button.

Figure 124.  Appellate CM/ECF For Mac Background Window

Figure 125.  Appellate CM/ECF For Mac Startup Page Window
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Known Differences for Mac Users
CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 130 before you attempt to start ECF.

Longer Startup Process

In order to maintain the same security for the ECF application for all users, the URL used behind 
the scenes for downloading the program to the Mac is different each time. This will make the 
startup process take longer for Mac users, since the URL will not be cached.

Automatic Login as a PACER User

Automatic login as a PACER user when an attorney logs in as a filing user is not supported on the 
Mac.

The default Mac browser must be used to log in to ECF. If a secondary browser is used, it will not 
know that you are logged in when running browser-based portions of the system. To change the 
default browser, go to Safari > Preferences > General. Use the Default web browser to indicate the 
default web browser.
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Right-Click Functionality

There are a few areas in ECF Appellate which feature right-click functionality. Mac users can 
access the same features by going to System Preferences > Keyboard and Mouse > Trackpad, and 
selecting the checkbox labeled Tap trackpad using two fingers for secondary click.

Figure 126.  Secondary Click
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Known Java Issues for Mac Users
CM/ECF needs Java Web Start to run correctly on Macintosh systems. With the latest Java update 
from Apple, the location of Java Web Start has changed and you may have to manually identify 
that location.

If you have Safari and Firefox, the Court recommends using Firefox to file electronically in 
order to avoid some of the issues described in this section.

Safari Browser is the Only Browser Installed on Your System
Assuming you followed the instructions for clearing the cache and cookies, you should be able to 
run CM/ECF without any problems.

Safari and Firefox Installed on Your System, Using Safari to Log In to CM/ECF
Assuming you followed the instructions for clearing the cache and cookies, and setting the default 
browser, you should be able to run CM/ECF to do your filings. However, PACER Report, Service 
List, and Help will open in a new Firefox window instead of the existing Safari window. As a result, 
the browser (Firefox) will not recognize that you are logged in to CM/ECF and will not allow you 
to run the reports. 

As a workaround, you can copy the URL from the Firefox window to a new tab in your Safari 
browser. For this reason, the Court recommends using Firefox to file electronically if you have both 
Safari and Firefox installed on your system.

Safari and Firefox Installed on Your System, Using Firefox to Log In to CM/ECF
Assuming you followed the instructions for clearing the cache and cookies, and setting the default 
browser, you should be able to run CM/ECF after following the steps below to find and identify 
Java Web Start:

1. Open Firefox.

2. Choose Firefox > Preferences.

3. In the dialog box that opens, click the Application icon at the top.
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4. In the Content Type box (on the left) scroll down to JNLP File and select that entry.

By default, the Action for this Content Type is set to Use Java Web Start (default), as shown 
in Figure 127.

5. In the Action box (on the right), select Use Other.

CAUTION:  Do not select Use Java Web Start (default).

A window titled Select Helper Application opens.

Figure 127.  Applications - JNLP File Content Type, Default Setting
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6. In the Select Helper Application window, under DEVICES, 
click Macintosh HD > System > Library > CoreServices > Java Web Start.

Figure 128 shows an example of the correct selections.

Figure 128.  Select Helper Applications Window
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7. Click the Open button (at the bottom of the window).

The Select Helper Application window closes and the Preferences dialog box (Applications) 
now shows the correct selection for the JNLP file. An example is shown in Figure 129.

8. Close the Preferences dialog box.

9. Restart Firefox and then follow the instructions in “To set Firefox as the default browser and 
clear the browser cache and cookies” on page 119 before attempting to log in.

Figure 129.  Applications - JNLP File Content Type Updated
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12 Filing Categories and 
Types of Motions

This chapter provides a complete list of the ECF filing categories and types of motions you can file. 

• “Briefs” on page 136

• “Motions/Responses/Replies” on page 138

• “Rehearing/Reconsideration” on page 142

• “Transcripts/Court Reporters” on page 143

• “Answers to Original Petitions” on page 144

• “Appeals Pursuant to FRAP 9(a)” on page 145

• “Forms/Notices/Disclosures” on page 146

• “Correspondence/Status Reports” on page 148

• “Prospective Amici and Intervenors” on page 149
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Briefs
An example of part of the File a Document window with the Briefs category selected is shown in 
Figure 130.

• Submit Brief for Review by the Court

• Submit Brief for Review and File a Motion Together
For a list of the types of motions that you can file, see “Types of Motions Available When 
Submitting a Brief and Filing a Motion Together” on page 137.

• File an Errata to a Brief

• File a Citation of Supplemental Authorities (FRAP 28(j) Letters)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

Figure 130.  Filing Category: Briefs
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Types of Motions Available When Submitting a Brief and Filing a 
Motion Together

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 40 
provides step-by-step instructions on how to use the Relief area.

• motion to file a late brief

• motion to file nonstandard brief

• motion to file oversized brief

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to reinstate case

• motion to withdraw as counsel
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Motions/Responses/Replies
An example of part of the File a Document window with the Motions/Responses/Replies category 
selected is shown in Figure 131.

• File a Motion. For a list of the types of motions that you can file, see “Types of Motions 
Available When Filing a Motion” on page 139.

• File a Response to a Motion/Form

• File a Motion and a Response to a Motion Together. For a list of the types of motions that you 
can file, see “Types of Motions Available When Filing a Motion” on page 139.

• File a Reply to a Response to a Motion

• File a Response to an Order to Show Cause

• File a Response to a Court Order

• File a Reply to a Response to an Order to Show Cause

• File a Reply to a Response to a Court Order

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order

• Submit Brief for Review and File a Motion Together. See “Briefs” on page 136 for additional 
information.

• File a Court Reporter Motion to Extend Time. See “Transcripts/Court Reporters” on page 143 
for additional information.

• File an Answer to an Original Petition

Figure 131.  Filing Category: Motions/Responses/Replies
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Types of Motions Available When Filing a Motion

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 40 
provides step-by-step instructions on how to use the Relief area.

• motion for 46-5 exemption

• motion for appointment of counsel

• motion for appointment of pro bono counsel

• motion for attorney fees

• motion for bail pending appeal or trial

• motion for certificate of appealability

• motion for certification to state supreme court

• motion for injunction pending appeal

• motion for miscellaneous relief (to be used only if no other relief applies)

• motion for sanctions

• motion for summary affirmance

• motion for summary disposition

• motion for summary reversal

• motion to assign case to prior panel

• motion to compel supplementation of excerpts of record

• motion to complete production of reporters transcript at government expense

• motion to consolidate cases

• motion to continue hearing

• motion to dismiss case for failure to prosecute under Circuit Rule 42-1

• motion to dismiss for lack of jurisdiction

• motion to dismiss party from case

• motion to dismiss the case

• motion to dismiss the case voluntarily pursuant to rule 42b

• motion to expedite case

• motion to extend time to comply with order
ECF User Guide -  139



Filing Categories and Types of Motions >  Motions/Responses/Replies
• motion to extend time to file CADS

• motion to extend time to file COA request

• motion to extend time to file FRAP 9a memorandum

• motion to extend time to file agency record

• motion to extend time to file appellant designation of reporters transcript

• motion to extend time to file appellee designation of reporters transcript

• motion to extend time to file appendix

• motion to extend time to file bill of costs

• motion to extend time to file brief

• motion to extend time to file opposition

• motion to extend time to file petition for rehearing

• motion to extend time to file record on appeal

• motion to extend time to file reply

• motion to extend time to file response

• motion to file a late brief

• motion to file addendum

• motion to file appendix

• motion to file joint brief

• motion to file late opposition (to file motion and opposition together)

• motion to file late petition for rehearing (to file motion and petition for rehearing together)

• motion to file nonstandard brief

• motion to file oversized brief

• motion to file oversized petition for rehearing

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to file supplemental briefing for petition for rehearing

• motion to file supplemental excerpts of record

• motion to hear case with other case
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• motion to join in existing brief

• motion to lift stay

• motion to present oral argument by video

• motion to proceed in forma pauperis

• motion to recall mandate

• motion to refer case to mediation

• motion to reinstate case

• motion to remand case

• motion to request publication of memorandum disposition

• motion to reschedule oral argument

• motion to stay lower court action

• motion to stay proceedings

• motion to stay proceedings pending settlement

• motion to stay removal/deportation

• motion to stay the mandate

• motion to strike portion or whole of document

• motion to submit case on briefs

• motion to substitute counsel

• motion to substitute party

• motion to supplement or amend Civil Appeals Docketing Statement

• motion to supplement or amend designation of reporters transcript

• motion to supplement record on appeal

• motion to take judicial notice

• motion to transfer appeal to other circuit

• motion to unseal document

• motion to waive filing of CADS

• motion to waive filing of excerpts of record

• motion to withdraw as counsel
ECF User Guide -  141



Filing Categories and Types of Motions >  Rehearing/Reconsideration
Rehearing/Reconsideration
An example of part of the File a Document window with the Rehearing/Reconsideration category 
selected is shown in Figure 132.

• File a Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1)

• File a Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1)

• File a Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40)

• File an Answer or Response to a Petition for Rehearing/En Banc

• File a Reply to an Answer to a Petition for Rehearing/En Banc

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order

Figure 132.  Filing Category: Rehearing/Reconsideration
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Transcripts/Court Reporters
An example of part of the File a Document window with the Transcripts/Court Reporters 
category selected is shown in Figure 133.

• File a Court Reporter Motion to Extend Time

• File Transcript Designation (9th Cir. R. 10-3)

• File Court Reporter Correspondence to Court

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)

Figure 133.  Filing Category: Transcripts/Court Reporters
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Answers to Original Petitions
An example of part of the File a Document window with the Answers to Original Petitions 
category selected is shown in Figure 134.

• File an Answer to an Original Petition

Figure 134.  Filing Category: Answers to Original Petitions
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Appeals Pursuant to FRAP 9(a)
An example of part of the File a Document window with the Appeals Pursuant to FRAP 9(a) 
category selected is shown in Figure 135.

• File a FRAP 9(a) Memorandum

• File a Response to a FRAP 9(a) Memorandum

• File a Reply to a Response to a FRAP 9(a) Memorandum

NOTE:  To file a motion to extend time to file a FRAP 9(a) memorandum, you must file a motion, 
and then select the motion to extend time to file FRAP 9a Memorandum relief. See “Filing a 
Motion” on page 61 for step-by-step instructions.

Figure 135.  Filing Category: Appeals Pursuant to FRAP 9(a)
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Forms/Notices/Disclosures
An example of part of the File a Document window with the Forms/Notices/Disclosures category 
selected is shown in Figure 136.

TIP:  You can download fill-in forms from the Court’s website. 
Go to http://www.ca9.uscourts.gov/, click the Downloads link, then click the arrow icon to the left 
of Forms and Guidelines. You must have Adobe Acrobat to save a fill-in form. If you do not have 
Adobe Acrobat, fill in the form, print the form, and then scan it so you can attach it to your filing.

• File a Response to a Motion/Form

• File Transcript Designation (9th Cir. R. 10-3)

• File a Notice of Appearance or Re-Assignment

• File a Civil Appeals Docketing Statement (Form 6)

• File Affidavit Accompanying In Forma Pauperis Motion (Form 4)

• File a CJA Form 23 Financial Affidavit

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

• File a Bill of Costs (Form 10)

• File an Application for Fees Under EAJA

• File a Certification for Law Student Representation Form

Figure 136.  Filing Category: Forms/Notices/Disclosures
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• File a Client Authorization of Law School Representation

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)
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Correspondence/Status Reports
An example of part of the File a Document window with the Correspondence/Status Reports 
category selected is shown in Figure 137.

• File a Citation of Supplemental Authorities (FRAP 28(j) Letters)

• File a Status Report Required by Court Order

• File Correspondence to Court

• File Court Reporter Correspondence to Court
See “Transcripts/Court Reporters” on page 143 for additional information.

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)

Figure 137.  Filing Category: Correspondence/Status Reports
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Prospective Amici and Intervenors
An example of part of the File a Document window with the Prospective Amici and Intervenors 
category selected is shown in Figure 137.

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Prospective Amicus or Intervenor Motion
For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

• Submit Brief and File Prospective Amicus or Intervenor Motion Together
For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

Types of Motions Available When Filing a Prospective Amicus or 
Intervenor Motion

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 40 
provides step-by-step instructions on how to use the Relief area.

• motion to become amicus

• motion to extend time to file amicus brief

• motion to extend time to file intervenor brief

• motion to intervene

Figure 138.  Filing Category: Prospective Amici and Intervenors
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13 Updating Your Appellate 
ECF Account

Since the Court is now live with Electronic Filing, all filers must update their own accounts. Do 
not send the Court notices of change of address or change of name, instead, follow the instructions 
in one of the following topics:

• “Updating a Company Name or Company Address” on page 152

• “Updating Your Email and Address When you Move to a Different Firm” on page 157
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Updating a Company Name or Company 
Address
CAUTION:  Follow the steps in this topic only if the name or address of your company has changed. 
If you changed firms, follow the instructions in “Updating Your Email and Address When you 
Move to a Different Firm” on page 157 instead.

For at least one attorney in your firm, do the following:

1. Navigate to https://pacer.psc.uscourts.gov/psco/cgi-bin/cmecf/ea-login.pl.

The login page is shown in Figure 139.

Figure 139.  Appellate Filer Account Update, Login Page
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2. Enter the attorney’s login and password and click the Verify Login button.

The Appellate CM/ECF Filer Account Update page opens. This page has three tabs: 
Maintenance, History, and Miscellaneous, as shown in Figure 140.

3. In the Maintenance tab, click the Personal Info/Address Updates link.

A page opens with one tab labeled Update Data. An example is shown in Figure 141.

Figure 140.  Appellate CM/ECF Filer Account Update Page

Figure 141.  Update Data Tab
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4. In the Update Data tab, click the Update Address Info link.

A screen opens with one tab labeled Address Maintenance. The system shows the address 
currently on file for the account. An example is shown in Figure 142.

Figure 142.  Address Maintenance Tab
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5. Click the Update button to the right of the address.

A screen opens with one tab labeled Update Address Information. An example is shown in 
Figure 143.

6. Make your changes to update the firm’s information (name, phone number, address).

Figure 143.  Update Address Information Tab
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7. Select the checkbox labeled Check here if this address change applies to the entire firm, as 
shown in Figure 144.

8. Click the Submit button to submit your changes to the PACER Service Center.

A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

9. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

10. Click the Logout link in the Miscellaneous tab.

Figure 144.  Checkbox to Indicate that Change Applies to Firm
156 -  ECF User Guide



Updating Your Appellate ECF Account >  Updating Your Email and Address When you Move to a Different Firm
Updating Your Email and Address When you 
Move to a Different Firm
CAUTION:  Follow the steps in this topic only if you changed firms and you need to update your 
company address and other contact information, such as phone numbers and email addresses. If the 
name of your firm has changed or if your firm moved to a new address, follow the instructions in 
“Updating a Company Name or Company Address” on page 152 instead.

1. Navigate to https://pacer.psc.uscourts.gov/psco/cgi-bin/cmecf/ea-login.pl.

The login page is shown in Figure 145.

Figure 145.  Appellate Filer Account Update, Login Page
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2. Enter your login and password and click the Verify Login button.

The Appellate CM/ECF Filer Account Update page opens. This page has three tabs: 
Maintenance, History, and Miscellaneous, as shown in Figure 146.

3. In the Maintenance tab, click the Personal Info/Address Updates link.

A page opens with one tab labeled Update Data. An example is shown in Figure 147.

4. In the Update Data tab, click the Update Personal Info link.

Figure 146.  Appellate CM/ECF Filer Account Update Page

Figure 147.  Update Data Tab
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5. In the Change Personal Information tab in the page that opens, update the Primary E-Mail 
Address and Verify Primary E-Mail fields with your new email address.

An example is shown in Figure 148.

6. Click the Submit button.

A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

7. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

8. In the Maintenance tab, click the Personal Info/Address Updates link.

A page opens with one tab labeled Update Data. An example is shown in Figure 149.

Figure 148.  Update Email Address

Figure 149.  Update Data Tab
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9. In the Update Data tab, click the Update Address Info link.

A screen opens with one tab labeled Address Maintenance. The system shows the address 
currently on file for the account. An example is shown in Figure 150.

Figure 150.  Address Maintenance Tab
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10. Click the Update button to the right of the address.

A screen opens with one tab labeled Update Address Information. An example is shown in 
Figure 151.

11. Make your changes to reflect your new firm and its contact information.

12. Click the Submit button to submit your changes to the PACER service center.

13. A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

14. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

15. Click the Logout link in the Miscellaneous tab.

Figure 151.  Update Address Information Tab
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